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Lifetime Measurement 
The activity (in decays per second) of some radioactive samples varies in time in a particularly 
simple way. If the activity (R) in decays per second of a sample is proportional to the amount of 
radioactive material (R ∝  N, where N is the number of radioactive nuclei), then the activity must 
decrease in time exponentially: 

R t R e t( ) = −
0

λ  

In this equation λ is the decay constant, commonly measured in s–1 or min–1. R0 is the activity at 
t = 0. The SI unit of activity is the becquerel (Bq), defined as one decay per second. 

You will use a source called an isogenerator to produce a sample of radioactive barium. The 
isogenerator contains cesium-137, which decays to barium-137. The newly made barium nucleus 
is initially in a long-lived excited state, which eventually decays by emitting a gamma photon. 
The barium nucleus is then stable, and does not emit further radiation. Using a chemical 
separation process, the isogenerator allows you to remove a sample of barium from the cesium-
barium mixture. Some of the barium you remove will still be in the excited state and will 
subsequently decay. It is the activity and lifetime of the excited barium you will measure. 

While the decay constant λ is a measure of how rapidly a sample of radioactive nuclei will decay, 
the half-life of a radioactive species is also used to indicate the rate at which a sample will decay. 
A half-life is the time it takes for half of a sample to decay. That is equivalent to the time it takes 
for the activity to drop by one-half. Note that the half-life (often written as t1/2) is not the same as 
the decay constant λ, but they can be determined from one another. 

Follow all local procedures for handling radioactive materials. Follow any special use 
instructions included with your isogenerator. 

OBJECTIVES 
•  Use a radiation counter to measure the decay constant and half-life of barium-137. 
•  Determine if the observed time-variation of radiation from a sample of barium-137 is 

consistent with simple radioactive decay. 
 

MATERIALS 
LabQuest  Cesium/Barium-137 Isogenerator 
LabQuest App cut-off paper cup for Barium solution 
Radiation Monitor  

 

PRELIMINARY QUESTIONS 
1. Consider a candy jar, initially filled with 1000 candies. You walk past it once each hour. 

Since you don’t want anyone to notice that you’re taking candy, each time you take 10% of 
the candies remaining in the jar. Sketch a graph of the number of candies for a few hours.  

2. How would the graph change if instead of removing 10% of the candies, you removed 20%? 
Sketch your new graph. 
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PROCEDURE 
1. Prepare a shallow cup to receive the barium solution. The cup sides should be no more than 

1 cm high.  

2. Connect the Radiation Monitor to DIG 1 of LabQuest. Choose New from the File menu. If 
you have an older sensor that does not auto-ID, manually set it up: 

a. Choose Sensor Setup from the Sensors menu. 
b. Select Radiation Monitor from the DIG 1 sensor list. 
c. Select OK. 

 
3. Set up the data-collection mode. 

a. On the Meter screen, tap Length.  
b. Change the data-collection length to 30 minutes. 
c. Enter 30 as the number of samples/minute. 
d. Select OK. 

 
4. Prepare your isogenerator for use as directed by the manufacturer. Extract the barium solution 

into the prepared cup. Work quickly between the time of solution extraction and the start of 
data collection in Step 5, for the barium begins to decay immediately. 

5. Place the radiation monitor on top of or adjacent to the cup so that the rate of flashing of the 
red LED is maximized. Take care not to spill the solution. 

6. Start data collection. The number of gamma photons that strike the detector will be counted 
during the 30-minute data collection period. Do not move the detector or the barium cup 
during data collection. 

7. As data collection continues a graph will be updated. When collection is complete, a final 
graph of radiation vs. time will appear. Set the radiation monitor aside, and dispose of the 
barium solution and cup as directed by your instructor. 

DATA TABLE 
Average background counts  

fit parameters for Y = A exp ( – B*X ) + C 

A  

B  

C  

λ  (min–1)  

t1/2  (min)  

 

ANALYSIS 
1. Inspect your graph. Does the count rate decrease in time? Is the decrease consistent with an 

activity proportional to the amount of radioactive material remaining? 
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2. Compare your graph to the graphs you sketched in the Preliminary Questions. How are they 
different? How are they similar? Why are they similar? 

3. The solution you obtained from the isogenerator may contain a small amount of long-lived 
cesium in addition to the barium. To account for the counts due to any cesium, as well as for 
counts due to cosmic rays and other background radiation, you can measure the background 
count rate from your data. By taking data for 30 minutes, the count rate should have gone 
down to a nearly constant value, aside from normal statistical fluctuations. The counts during 
each interval in the last five minutes should be nearly the same as for the 20 to 25 minute 
interval. If so, you can use the average rate at the end of data collection to measure the counts 
not due to barium. To do this. 

a. Tap and drag across the data on the graph between 25 and 30 minutes. 
b. Choose Statistics from the Analyze menu.  
c. Record the average (mean) value in your data table. You will use this value to compare 

with a curve fit parameter.  
 
4. Fit an exponential function to the first fifteen minutes of your data. 

a. Tap and drag from the first point across the graph to the data point that was collected at 
15 minutes. 

b. Choose Curve Fit from the Analyze menu. 
c. Select Natural Exponent as the Fit Equation.  
d. Record the fit parameters A, B, and C in your data table. 
e. Select OK view the fitted curve with your data.  

 
5. Print or sketch your graph. 

6. From the definition of half-life, determine the relationship between half-life (t1/2, measured in 
minutes) and decay constant (λ, measured in min-1). Hint: After a time of one half-life has 
elapsed, the activity of a sample is one-half of the original activity. 

7. From the fit parameters, determine the decay constant λ and then the half-life t1/2. Record the 
values in your data table. 

8. Is your value of t1/2 consistent with the accepted value of approximately 2.552 minutes for the 
half-life of barium-137? 

 9. What fraction of the initial activity of your barium sample would remain after 25 minutes? 
Was it a good assumption that the counts in the right side of the graph would be due entirely 
to non-barium sources? 

EXTENSIONS 
1. How would a graph of the log of the count rate vs. time appear? Using LabQuest, 

Logger Pro, or a spreadsheet, make such a graph. Interpret the slope of the line if the data 
follow a line. Will correcting for the background count rate affect your graph?  

2. Repeat your experiment several times to estimate an uncertainty to your decay constant 
measurement. 

3. How long would you have to wait until the activity of your barium sample is the same as the 
average background radiation? You will need to measure the background count rate carefully 
to answer this question. 
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1. The student pages with complete instructions for data collection using LabQuest App, 

Logger Pro (computers), DataMate (calculators), and DataPro (Palm handhelds) can be found 
on the CD that accompanies this book. See Appendix A for more information. 

2. Alert readers may notice that the Preliminary Questions are the same as those in 
Experiment 24 (Capacitors) of Physics with Vernier. This duplication is intentional, as both 
the decay in capacitor potential in an RC circuit and radioactive decay are described by 
exponential functions. You may wish to call your students’ attention to this. 

3. Sources are available from a number of suppliers: 

•  Spectrum Techniques, (865) 482-9937, Fax: (865) 483-0473, 
www.spectrumtechniques.com. 

•  Flinn Scientific, (800) 452-1261, Fax: (630) 879-6962, www.flinnsci.com.  
•  Canberra Industries, (800) 243-3955 Fax: (203) 235-1347, www.canberra.com. 
 

4. Detailed directions for preparing the isogenerator are not given because the method varies 
with manufacturer. You may want to insert the instructions appropriate to your isogenerator 
at Step 2 of the Procedure. 

5. Students often confuse the decay constant parameter λ with the half-life t1/2. The decay 
constant λ is larger for more rapidly decaying elements and has dimensions of time–1, while 
the half-life has dimensions of time, and is smaller for more rapidly decaying elements. The 
decay constant λ is equal to the fit parameter C in the Natural Exponential fit of Logger Pro 
and LabQuest. The two parameters can be related in the following manner. After one half-life 
has elapsed, half of the radioactive nuclei have decayed, and so the activity is also cut in half. 
From the rate equation we can relate the decay constant to the half life. 
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There is sufficient information in the student guide to perform this conversion, although some 
students with weak algebra skills may have difficulty with it. You may choose to work 
through this step with your students. 
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6. The cesium-137 in the isogenerator decays to a metastable state of barium. The metastable 
barium decays with a half-life of 2.552 minutes by gamma emission, making this system an 
ideal one for studying in the classroom. A 30 minute experimental run covers almost twelve 
half-lives, so that the observed activity drops to about 0.3% of the initial value. 

7. The lifetime obtained depends strongly on the correct subtraction of background (in this case, 
non-barium) counts. As written, the activity instructions call for a 30-minute data collection 
period. If time permits, use a 45 or 60 minute period, and measure the count rate for the final 
10 or 15 minutes. A longer experiment will ensure that essentially all the barium will have 
decayed. The sample data shown here yield a lifetime of 2.50 minutes, but if the background 
value obtained during the last 10 minutes of a 60 minute run is used, the lifetime changes to 
2.57 minutes. 

8. Many isogenerators allow some cesium to leak through into the barium extract solution. The 
cesium results in a nearly constant background activity. This background count is often much 
larger than the environmental background, and the analysis must take it into account. That is 
why the experiment is written to run for 30 minutes. The final 5 minutes of data can be used 
to determine the count rate from the combination of cosmic rays and leaked cesium. If you 
have an isogenerator that does not leak significant amounts of cesium, you may want to 
shorten the experiment to fifteen minutes. 

9. In Step 4 of Analysis students perform a curve it on only the first 15 minutes of data. This is 
important, because the fit will sometimes be poorer if all 30 minutes of data are used. The 
counts during the first 15 minutes are largely due to the barium, while the counts in the last 
15 minutes are mostly from non-barium sources. The many noisy points in the tail of the 
exponential may unduly influence a fit of the entire run. 
 
You may want to have students investigate this effect, or to try various selections of data 
during the first 15 minutes (e.g., 2–13 minutes, or 5–15). The resulting value for the lifetime 
will vary somewhat, giving an indication of the uncertainty of the measurement. Using our 
data we get variations about 0.05 minutes around the typical value shown here. 

10. Note that the calculator, computer, LabQuest, and Palm versions of the activity use different 
notation for the fitted equation. Unlike Logger Pro and LabQuest, the calculator program 
DataRad and the Palm program DataPro, uses seconds as the x-axis time unit, so that the 
exponential fit parameter must be converted from s-1 to min-1 (s-1

 = 60 min-1) to obtain a 
lifetime in min-1. 
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SAMPLE RESULTS 

 

     
Raw data from calculator and background subtraction step. 

   
Exponential fit to the first 15 minutes of data after background subtraction. 
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ANSWERS TO PRELIMINARY QUESTIONS 
1. Graph is a decaying exponential. The first few values are 1000, 900, 810… (with integer part 

of 10% taken each time). 

2. Second graph decays more quickly: 1000, 800, 640…  

      

DATA TABLE 
(computer) 

Average background counts 17 

fit parameters for Y = A exp ( – C*X ) + B 

A 554 

B 17 

C 0.277 

λ  (min–1) 0.277 

t1/2  (min) 2.50 
 
(calculator) 

fit parameters for Y = A exp ( – B*X ) + C 

A 7129 cpm 

B 0.00444 s-1 

C 182 cpm 

λ  (min–1) 0.266 

t1/2  (min) 2.60 
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ANSWERS TO ANALYSIS QUESTIONS 
1. The count rate decreases in time, falling to less than 10% of the initial value. This is 

consistent with activity being proportional to the amount of remaining radioactive material, 
since as material decays, less remains, so the activity must decrease. 

2. The three graphs have a similar decreasing shape, although the time-axis scale of the barium 
data is different from that of the candy graphs. The vertical axes have different units (candy 
remaining and counts/interval). They are similar because in each case the decay process 
proceeds at a rate proportional to the remaining candies or radioactive nuclei. 

 6. We start with the rate equation, and then use the definition of the half-life as the time it takes 
for the activity to drop to one-half the original value: 

 

R = R0e−λt ; at t = t1/ 2  R = 1
2 R0

1
2

= e−λt1/ 2

− ln2 = −λ t1/ 2

t1/ 2 = ln 2
λ

 

 8. The experimental half-life of 2.50 min is close to the accepted value of 2.552 s.  

 9. After 25 minutes, 0.11% of the original barium activity remains. (e–25*0.272 = 0.0011). Most, 
but not quite all of the original activity has decayed. The assumption that the counts observed 
during the last five minutes of data collection are due only to non-barium is reasonable. 
Possibly a better background estimate could be obtained by waiting a longer time.  

ANSWERS TO EXTENSIONS 
1. A graph of ln(counts/interval) vs. time should be a straight line of negative slope. The slope is 

–λ, or the negative of the decay constant. If the background has been subtracted, the graph 
should be nearly linear. Without background subtraction, the graph will be curved. 

2. Results will vary. A collection of lifetime measurements will allow the student to determine a 
range of values; the extent of that range is a measure of the uncertainty of the measurement. 
The range of data selected will also influence the measurement, as will the value used for the 
additive parameter B in the exponential curve fit. 

3. Results will depend on the background radiation level. Experiments done at high altitude will 
experience larger background count rates due to reduced attenuation of cosmic rays by the 
atmosphere. To measure the background rate, change your set up to count with no source 
present. Note that the solution obtained from the isogenerator will contain some cesium, 
raising the count rate further above background from environmental radiation. 


